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Using folder lists and page
tabs to navigate in FrontPage
by Mark Ray 

Application: Microsoft FrontPage 2000/2002
Operating System: Microsoft Windows

these tools, you can still read on to learn
how they differ. If you’ve been strug-
gling to navigate between pages, the
article will provide you with a good
basic introduction.

We will begin by looking at the Folder
List and show you how to access this 
feature in various FrontPage views. Next,
we’ll move on to FrontPage 2002’s Nav-
igation Pane, which gives you a slight-
ly different view of your Web. Finally,
we’ll show you a couple of ways that 
you can navigate between open pages in
FrontPage.

Working with 
all files
Perhaps the most useful
list FrontPage provides
is the Folder List. This
list, which is an inte-
gral part of the Folders
view shown in Figure A,
shows all the folders in
your Web and lets you
open them to view their
contents on the right
side of the window. As

W hile it’s not the most difficult 
aspect of using FrontPage, 
navigating between pages can

be annoying. It’s also a frequently used
skill; after all, it’s the rare Web that con-
sists of a single page. In this article we’ll
show you a couple of quick ways to navi-
gate between the pages in your Web.

Listing the lists
FrontPage displays your Web’s content
in a number of places, of which the
Folder List and the Window menu are
the most useful. If you’re familiar with

Figure A: The Folder
List always appears as
part of the Folder view.
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in other Windows applications, an open folder
icon indicates the currently selected folder.

What so many users don’t realize is that the
Folder List is also available in Page, Navigation
and Hyperlink views. To make it visible, simply
click the Folder List button ( ) on the Standard
toolbar.

Figure B shows the Folder List in Page view.
Although the figure shows the same Web as Fig-
ure A, the Folder List looks a little different here.
Instead of the folder contents appearing in a sep-
arate section of the FrontPage window, they’re
integrated with the folders themselves.

Note: You can resize the Folder List by drag-
ging on its right border. 

Regardless of which FrontPage view you’re
in,  you can perform a number of operations on

any file you see. Double-clicking on a file opens
it in the associated editor, while right-clicking on 
a file brings up the shortcut menu shown in Fig-
ure C. (FrontPage 2002 displays a more exten-
sive menu.)

Navigation in FrontPage 2002
The Folder List button in FrontPage 2002 ( )
looks a little different than in FrontPage 2000.
More importantly, it has a small down arrow
next to it. When you click on this arrow in Page
view (but not in the other views), you can
choose between the Folder List described above
and the new Navigation Pane. (When either the
Folder List or the Navigation Pane is visible, you
can toggle between the two lists with the but-
tons at the bottom.)

The Navigation Pane, shown in Figure D, dis-
plays your Web’s navigation structure in tree
form, much like the Folder List. Note that you’ll
only be able to access pages that you’ve added
to the navigation structure. When you right-
click on a file, you can access the same shortcut
menu that you’d see in Navigation view.

Working with open files
The best way to see a list of all the open pages in
your Web is the Window menu, shown in Figure
E. Although this menu appears in most Win-
dows programs, users often forget about it—
perhaps because it’s so ubiquitous.

The Window menu lists up to nine open doc-
uments; you can access additional documents
by choosing More Pages at the bottom. In addi-
tion to letting you quickly switch between
pages, the menu also indicates which pages
haven’t been saved since you last edited them—
just look for an asterisk (*) after each unsaved
page’s name.

If you’ve upgraded to FrontPage 2002,
you’ve probably noticed that that version offers
a handy alternative to the Window menu. In
Page view, a series of folder-style tabs appear
just above the page you’re editing, and you can
use these tabs to navigate between pages. As
with the Window menu, unsaved pages are
marked with an asterisk.

Note: FrontPage 2002 can display an un-
limited number of page tabs. When it’s nec-
essary, small navigation buttons appear to the
right of the last tab, allowing you to move
between the tabs.

You can also use the keyboard to quickly
move between open pages. To do so, press

Figure C: You can
right-click on a file to
rename it, delete it or
view its properties.

Figure D: FrontPage 2002
introduces the Navigation
Pane, an alternative to the

Folder List.

Figure B: You can also
access the Folder List from
Page view.
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Figure E: The useful Window
menu often seems hidden in
plain sight.

[Ctrl][Tab] or [Ctrl][Shift][Tab]. (For more useful
shortcuts, see the article, “Secret FrontPage key-
board shortcuts,” in the September 2001 issue of
Inside Microsoft FrontPage.)

Folder flexibility
As we’ve demonstrated in this article, FrontPage
gives you a variety of methods for navigating
among the files in your Web. A little experimen-
tation will help you determine which method
works best for you. 

Analyze your Web with FrontPage
reports
by Mark Ray

Application: Microsoft FrontPage 2000/2002
Operating System: Microsoft Windows
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Even moderately large Web sites can quickly 
outpace your ability as a webmaster to 
keep track of them. Over the course of

weeks or months, you can easily end up with
orphaned pages, broken hyperlinks, pages that
load too slowly and other problems.

To help you identify these problems—or sim-
ply learn more about your Webs—FrontPage
2000 and 2002 offer a comprehensive set of
reports. As we’ll see in this article, you can use
these reports to identify slow-loading pages,
review recently changed or added files, check
hyperlinks and even (in FrontPage 2002) analyze
visitor traffic.

Reporting live
If you’re already familiar with the reporting fea-
ture, you can still read this article to learn about
the enhancements FrontPage 2002 makes to the
reports, some of which are so subtle that you
might miss them. If you’re totally unfamiliar
with the reporting feature, you’ll find this article
fairly comprehensive.

To use reports, you must first access them, so
we’ll start by showing you the two ways you
can access FrontPage’s reports. Once that’s cov-
ered, we’ll briefly introduce you to all of the
reports and show you how to change some
important report parameters, such as the defini-
tions of “slow” pages and “older” files. Finally,

we’ll discuss the reporting enhancements found
in FrontPage 2002.

Accessing reports
To get started, launch FrontPage and open an
existing Web. Then, click the Reports button on
the Views bar to switch to the view shown in
Figure A. Note that two things happen at once
when you click Reports: FrontPage displays the
Site Summary report and it displays the Report-
ing toolbar. In FrontPage 2000, this toolbar floats

Figure A: The Site Summary report presents an overview of your Web.
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somewhere near the middle of the window; in
FrontPage 2002, it’s anchored below the Format-
ting toolbar.

Figure B: All the files in this report take more than 30 seconds to
download.

Figure C: By double-clicking on a broken hyperlink, you can
access this dialog box and fix it.

Figure D: In FrontPage 2002, you can filter your reports by a
variety of criteria.

As its name implies, the Site Summary report
gives you an overview of your Web, including
the number of pages it contains, how much
space it consumes on the server, and how many
hyperlinks it includes. This report is useful by
itself, but it’s really just the beginning. You can
double-click on most of the line items—single-
click in FrontPage 2002—to access a report that
provides more detail on that item. 

Note: FrontPage’s reports only look at those
files that are currently visible in the FrontPage
environment. If you have files saved in hidden
directories that you want included in reports,
choose Web Settings from the Tools menu. In
the Web Settings dialog box that appears,
switch to the Advanced property sheet, enable
the Show Documents In Hidden Directories
check box (Show Hidden Files And Folders in
FrontPage 2002), and click OK.

For example, double-click on the Slow Pages
line item now (single-click in FrontPage 2002).
As shown in Figure B, FrontPage displays any
files in your Web that take longer than 30 sec-
onds to download at 28.8 Kbps.

Working with a report
The files are automatically listed in order of their
estimated download time. However, you can
sort the report by any column; to do so, just click
the column header. (Clicking the same column
header again reverses the sort order.)

You can also change the width of a column by
dragging on the right edge of its column header.
If necessary, FrontPage displays a horizontal
scroll bar at the bottom of the window.

Besides changing a report’s appearance, you
can often change its content. Notice that the
Reporting toolbar includes a Report Setting
dropdown list that currently displays 30 seconds.
By clicking on that list, you can change your
slow-page threshold. 

Many of FrontPage’s reports include parame-
ters that you can change from the Reporting
toolbar, and most allow you to sort by any col-
umn or resize the columns as we did earlier.
Another feature the reports share is that you can
double-click on most report items to take action.
For example, if you double-click on a filename 
in the Slow Pages report, FrontPage opens that
file in the appropriate editor. In the Broken
Hyperlinks report, on the other hand, double-
clicking a hyperlink allows you to fix it, as
shown in Figure C.



Filtering the data
In FrontPage 2002, you can also fil-
ter the contents of almost any
report to home in on particular
information. At the right edge of
each column header is a small tri-
angular button called the AutoFil-
ter button. Clicking this button
brings up a pop-up menu that lists
all the values that appear in that
column. For example, a report’s
Type column would list such val-
ues as HTM, HTML, GIF and JPEG.
To filter by one of those values,
simply select the value from the
list; the AutoFilter button turns
blue to remind you that filtering is
active. (This is important because
FrontPage preserves your filtering
options even after you close the
program.)

The pop-up menu also includes
an All option, which removes filter-
ing, and a Custom option, which
lets you set more elaborate filtering
criteria. Figure D shows the Cus-
tom Auto-Filter dialog box that
appears when you select Custom.

Using other reports
You can switch to another report by
choosing its name from the Report-
ing toolbar’s Reports dropdown
list. In addition, you can choose
Reports from the View menu and
then select the report you want
from the submenu that appears.

Table A describes the reports
that are available in both Front-
Page 2000 and 2002. FrontPage
2002 also includes 13 usage reports,
which are described in the article
“Usage analysis comes to Front-
Page” in this issue.

Exporting reports 
in FrontPage 2002
One of the major limitations of the
reporting feature in FrontPage 2000
is that there’s no way, short of using a screen-
capture utility, to use the data outside Front-
Page’s Reports view. Microsoft addressed this
limitation—at least to some extent—in FrontPage
2002. You still can’t print a report, but you have
two other options for manipulating the data.
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Table A: FrontPage 2000 and 2002 reports

Report Description
Site Summary An overview of the entire Web

All Files Lists all files in the Web (like the All Files view 
in FrontPage 98)

Recently Added Files Files you’ve added in the last x days

Recently Changed Files Files you’ve changed in the last x days

Older Files Files that haven’t changed in the last x days

Unlinked Files Files that can’t be reached from links on the 
home page

Slow Pages Pages that load in more than x seconds at a 
given connection speed

Broken Hyperlinks Links FrontPage hasn’t verified or has found to 
be broken

Component Errors FrontPage component problems

Review Status Lists the review status (e.g., Code Review, Legal 
Review) of all your files

Assigned To Indicates to whom you’ve assigned files

Categories Lists category assignment(s) of each file

Publish Status Indicates whether you’ve marked files to be 
published

Checkout Status Indicates whether files have been checked out

Figure E: You can save almost all reports as HTML documents.

The easiest option is to right-click on the
report and choose Copy Report from the short-
cut menu. This copies the report to the Windows
Clipboard as an HTML table. You can then paste
the data into a new HTML document (or a Word
or Excel document) to format and print it.



tions. In that environment the default settings of
the Slow Pages parameter (30-second load time
at 28.8 Kbps) don’t make sense.

To change the parameter, choose Options
from the Tools menu to open the Options dialog
box. Then, switch to the Reports View property
sheet, as shown in Figure F. Here, as you can
see, you can change the definition of a slow
page. For the intranet example, you might set
the number of seconds to 10 and the connection
speed to ISDN.

In this dialog box, you can also change the
definitions of recent and older files. (The
recent-files setting affects both the Recently
Added Files and Recently Changed Files
report.) You can also change two parameters
related to FrontPage 2002’s usage re-ports. Any
changes you make in this dialog box override
changes you’ve made via the Reporting tool-
bar. The settings are also preserved when you
close the program.

Tuning up your Webs
FrontPage’s built-in reports are a great way to
monitor your site for the sorts of problems
users are likely to encounter. As long as you
review the reports regularly—and act on your
findings—you can quickly identify and correct
most common Web site problems. 
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Figure F: Change the report parameters
to fit your needs. FrontPage 2002 includes
additional options not shown here.

Usage analysis comes to FrontPage
by Mark Ray

Application: Microsoft FrontPage 2002
Operating System: Microsoft Windows

B efore the appearance of FrontPage 2002, 
FrontPage users could only analyze their 
visitor traffic with hit counters—a notori-

ously unreliable technique—or with third-party
software such as WebTrends Log Analyzer. While
some Web presence providers offer usage reports
as part of their hosting packages, others do not,

and programs like WebTrends can cost hundreds
of dollars. Now, however, FrontPage 2002 has
added usage analysis to the array of offerings in
the Reports view. While FrontPage’s built-in
usage reports may not be as robust as those cre-
ated by dedicated log-analysis programs, they
have one major advantage: they’re free.

The other option is to choose Save As from
the File menu. A standard Save As dialog box
appears, prompting you to save the report as
an Excel HTML file, as Figure E shows on the
previous page.

Changing report parameters
We showed you earlier how to change report
parameters on the fly from the Reporting menu.
You can also make your changes permanent in
the Options dialog box.

For example, let’s say that you only develop
Web pages for a corporate intranet, where 100
percent of your users have ISDN or T1 connec-
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Note: To use FrontPage 2002’s usage reports,
your server must be running the FrontPage
2002 Server Extensions or SharePoint Team
Services. Also, the usage reports are only
available for root Webs.

The same yet different
If you’re familiar with FrontPage’s reporting fea-
ture, you won’t have much trouble working
with the usage reports since they rely on a simi-
lar interface. However, you’ll want to read on to
learn how to enable the tracking of usage data.

If you’ve never used any type of log-analysis
software, this article will introduce you to some
of the key data that FrontPage’s usage reports
include. We’ll begin by introducing you to the
Usage Summary report, which highlights key
data. Next, we’ll explain what each of the other
reports tracks and why the information is
important. Finally, we’ll show you how to mod-
ify a couple of key report parameters. As you’ll
discover, the information FrontPage’s usage
reports provides is both more accurate and more
comprehensive than hit counters.

Flipping the switch
Unlike FrontPage’s other reports (which are dis-
cussed in the article “Analyze your Web with
FrontPage reports” in this issue), the usage
reports rely on data that’s collected on the server.
Since data collection isn’t turned on by default,
the first thing you must do is to turn it on.

If you’re not the server administrator, you’ll
need to contact your Web presence provider for
assistance. Make sure that the latest server
extensions are installed and ask that data collec-
tion be enabled.

If you’re the server administrator, you can do
the job yourself by choosing Tools | Server |
Administration Home to access your Web’s
administration page. Enter your username and
password and then scroll down to the Configure
Usage Analysis Settings section, where you’ll find
a Change Usage Analysis Settings link. Click that
link, and the page shown in Figure A appears.

Here, you can turn on data collection and also
specify how frequently—and when—the raw data
should be processed. We recommend processing
usage data at midnight each day; that way, you’ll
easily be able to analyze day-by-day traffic.

You can also register to be notified by email
each time usage analysis occurs. However, if
you select this option, you’ll probably end up
turning it off after a while since the email mes-
sages don’t tell you anything more than the

Figure B: The Usage Summary report offers a quick overview of your
site traffic.

Figure A: Besides enabling data collection, you can specify when usage
analysis should occur.

Figure C: These 13 reports
let you analyze your usage
data from several different
perspectives.
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fact that analysis has occurred at the time you
specified.

Analyze this
Once data collection is turned on, you’ll have to
wait until log processing occurs before you can
check your usage statistics. At that point, choose
View | Reports | Usage | Usage Summary to
get an overview of the statistics FrontPage
tracks. Figure B on the previous page shows the
Usage Summary report for a typical Web.

Like the Site Summary report discussed in the
article “Analyze your Web with FrontPage
reports,” the Usage Summary report serves as a
quick entry point to a number of other reports;
about two-thirds of the items listed here are
hyperlinked to reports that offer more detail.

So what does the Usage Summary report tell
you? The information in the Description col-
umn explains each entry fairly well, but one
distinction may not be immediately apparent.
The first five entries—Date Of First Data
through Total Bytes Downloaded—give cumu-
lative statistics from the moment data collec-
tion was enabled; the other entries are for the
current month only. (Initially, of course, this
distinction will be irrelevant.)

The Usage Summary report isn’t the only
summary report you can access. As the sub-
menu in Figure C on the previous page shows,
the others are the Monthly Summary, Weekly
Summary and Daily Summary reports.

Each of these reports displays the total num-
ber of visits, hits and total hits for the specified
period. These terms all sound similar, and they
actually give three views of the same data. So,
what do they measure? Total Hits measures the
number of times any file was requested. Hits
measures unique file requests, ignoring multiple
requests by the same user. Visits measures the
number of different users who visited your site.

On the Monthly Summary report, you’ll also
find a Download Size column, telling you how
many kilobytes worth of files were downloaded
from the site each month. The other summary
reports include a Percentage Of Hits column,
which can help you determine when your site’s
getting the most traffic.

Reports galore
You can go far beyond just the summary reports
to zero in on specific data. As Figure C shows,
the remaining usage reports are divided into
three groups: hit reports, visitor reports and
referrer reports.

The three hit reports present the raw data 
that supports the Monthly, Weekly and Daily
Summary reports discussed in the previous sec-
tion. You can see not only the total number of
hits each file on your site received, but also the
number of hits received every day, week or
month, as shown in Figure D. You’ll need to
scroll to see all the data, and you may want to
sort or filter the data—as discussed in the article
“Analyze your Web with FrontPage reports”—to
focus on just the information you’re interested in.

Next comes a group of reports that tell you a
little about the people visiting your site. The Vis-
iting Users report lists users who have logged on
to your site (assuming it’s password-protected);
anonymous users fall into the All Others cate-
gory. The Operating Systems and Browsers
reports are self-explanatory; they can be quite use-

Figure D: You can crunch as many numbers as you want with the Daily
Page Hits report.

Figure E: You can modify report parameters in the
Options dialog box.



Using default pages to point site
visitors in the right direction
by Mark Ray 

Application: Microsoft FrontPage 98/2000/2002
Operating System: Microsoft Windows
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ful if your site includes features that only certain
browsers or operating systems support.

Finally, the referrer reports tell you how peo-
ple found your site. The Referring Domains
report lists all the domains that have referred
users to your site, either through searches or
actual hyperlinks. The Referring URLs report
lists the actual pages from which users came to
your site. (When users arrive at the site by typ-
ing the URL directly into the browser, no referrer
appears in these reports.) The last report, Search
Strings, lists the search text that led people to
your site.

Changing report parameters
As with the other FrontPage reports, you can
modify a couple of usage-report settings in the
Options dialog box. To access this dialog box,

choose Options from the Tools menu and then
switch to the Reports View property sheet, as
Figure E shows.

The first option lets you specify how many
months’ worth of data should be included when
FrontPage calculates usage reports. The second
lets you include a chart as part of each report
that you save.

Data mining
FrontPage’s built-in usage reports provide a
wealth of data about who’s visiting your site
and which pages they’re accessing. Coupled
with the integrated charting feature, which
we’ll discuss in a future article, you can use
the reports to gain important insights into
your site usage and make any tweaks you
deem necessary. 

Y our FrontPage Web may contain dozens, 
hundreds or even thousands of individ-
ual HTML pages, but one of those

pages—the default page—is by far the most
important. That’s because it’s the page that the
Web server will display if a user types your URL
without a specific page name attached. For
example, if your home page is www.myURL
.com/index.htm, users could simply type www
.myURL.com to access it. In this article, we’ll
explore some important aspects of defining and
using default pages.

What’s in a name?
This article will give you a good introduction to
naming default pages. We’ll tell you which
names are most commonly used on which server
types and how to change your default page’s
name if it doesn’t match your server’s settings.

If you’re an experienced Web developer, you
may be familiar with these concepts. However,
we’ll also show you how to use default pages
and redirects to protect your directories from
prying eyes.

Naming conventions
When it’s deciding which page to display by
default, the Web server goes through a pre-
determined list. If it finds a page from that 
list—index.htm, for example—it displays it; oth-
erwise, it displays a list of the files in the site’s
root directory. The same concept applies to the
directories within your site. If a user types
www.myURL.com/images/, for example, he’ll see a
list of the files in that directory—unless the
server finds a default page there.

Each Web server is configured to look for cer-
tain default pages. In general, a Windows server
first looks for Default.htm; if it can’t find that
page, it then looks for Default.html, Default.asp,
etc. A UNIX server, on the other hand, first looks
for index.htm or index.html. (Keep in mind that
names in UNIX are case-sensitive; index.htm
isn’t the same as Index.htm.)

At the same time, your local FrontPage Web
has a single page that’s designated as the home
page. In FrontPage 2000 and 2002, you can tell
which page is the home page by viewing the
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site’s structure in Navigation view; the page’s
icon includes a small house logo, as shown in
Figure A. In FrontPage 98, the home page is the
page whose icon appears at the top of the direc-
tory tree in Navigation view.

So what happens if your home page is named
index.htm and the Web server is looking for
Default.htm? If the server has the FrontPage
Server Extensions installed, you don’t need to
worry. When you publish the Web, FrontPage
changes the home page’s name as needed to
match the first name on your server’s list of
default page names; it also fixes any hyperlinks

to the page. (This only affects the files on the
server, not files on your hard drive.) You may
not even notice that this is happening, although
the message shown in Figure B appears briefly
during the publishing process.

If your Web server doesn’t have the exten-
sions installed, you’ll need to check with your
Web presence provider and find out what you
should name your default page. If you’re using
the wrong name, you’ll need to change the
page’s name in FrontPage.

To do so, right-click on the page in Folders
view and choose Rename from the shortcut
menu. Depending on your site and your version
of FrontPage, several dialog boxes may appear.
The first (which only appears in FrontPage 2002)
warns you that you’re renaming your home
page, as shown in Figure C; click Yes. If you’re
changing the page’s file extension, another dia-
log box warns you that doing so may make the
file unusable. Click Yes here as well. Finally, you
may be asked if you want to update any hyper-
links to the page; again, click Yes.

Directory assistance
Default pages do more than just get users into
your Web site. They also keep users out of parts
of your site they shouldn’t view.

Let’s assume, for example, that your Web
includes the standard images directory. Depend-
ing on your server’s configuration, a user typing
www.myURL.com/images/ in the browser could
end up viewing a directory listing like the one in
Figure D. At best, such a listing can confuse site
visitors; at worst, it can allow them to poke
around parts of your site they shouldn’t see.

Fortunately, the solution is simple: Just add a
default page to each directory in your Web. Each
page should have the same name as your Web’s
home page.

In some cases, you may want these default
pages to contain actual content. In other cases,
however, you’ll simply want to redirect users to
another page. In the latter case, open the direc-
tory’s default page in FrontPage’s HTML mode
and add the following code just before the
</head> tag:

<meta http-equiv=”refresh” content=”0; 

URL=../index.html”>

This meta tag tells the browser to load the
page index.html, which is located in the parent
directory of the current directory. The redirect
happens in zero seconds, so the transition is vir-
tually seamless.

If you aren’t comfortable specifying the rela-

Figure A: FrontPage 2000 and 2002 indicate the home page with a
special icon.

Figure C: FrontPage
warns you when you

try to rename the
home page.

Figure B: If the server
extensions are present,

FrontPage automatically
renames your home page 

to match the server’s 
configuration.
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tive URL of the page to which users should be
redirected, you can instead specify an absolute
URL: http://www.myURL.com/index.html, for
example.

Home sweet home page
When the Web was new, most users carefully
typed in every URL exactly as presented, such as
http://www.myURL.com/index.html. These days,
however, they’re likely to type myURL.com and
expect the correct page to appear. That’s why it’s
more important now than ever to specify the
correct default page in your Web—and in all the
directories within your Web. 

Figure D: If no default page
appears in a directory, users

may well see a listing like this.

Creating an invisible hit counter 
in FrontPage
by Mark Ray 

Application: Microsoft FrontPage 98/2000/2002
Operating System: Microsoft Windows

I n the parlance of the moment, hit counters 
are so yesterday. While it was once popular 
to trumpet your site’s popularity (or lack

thereof) on your home page, many people now
consider hit counters to be a hallmark of ama-
teur Web-site design, much like blinking “Under
Construction” images.

That’s not to say that hit counters are com-
pletely useless, however. In fact, by making your
hit counters invisible, you can silently gather hit
data while keeping your pages free of visual
clutter. We’ll show you how in this article.

Counter-intuitive
If you’re familiar with the Hit Counter compo-
nent, you can still read through this article to
learn how to substitute invisible digits for the
digits FrontPage ordinarily uses. If you’ve never
used hit counters before, we’ll give you a quick
introduction.

We’ll begin by explaining how FrontPage
uses counter images and where it stores counter
data. Then, we’ll show you how to specify a cus-
tom—and invisible—counter image. Finally,

we’ll explain how to check the counter results
from within FrontPage.

Getting started
While you might think it takes 10 separate digit
images to create a hit counter, FrontPage actu-
ally uses a single image like the one shown in
Figure A. The program slices this image into 10
equal pieces on the fly, using the first slice for 0,
the second slice for 1, etc. To implement our
technique, we’ll use a transparent GIF image
that has a height and a width of just one pixel
instead of an image like the one shown in the
figure. FrontPage will still slice and display this
image, but site visitors won’t notice it.

You can create a transparent one-pixel-square
GIF image in your favorite image-editing pro-
gram, or you can simply download blank.gif

Figure A: FrontPage uses images like this to display hit data.
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from our FTP site at ftp.elementkjournals.com
/mfp/blank.gif. Once you’ve downloaded the
image, import it into your Web’s images folder.

Next, you must add a hit counter to your
page and access the Hit Counter Properties dia-
log box, shown in Figure B. Doing so requires
slightly different steps depending on your ver-
sion of FrontPage. In FrontPage 98 Editor, choose
Insert | FrontPage Component; in the dialog box
that appears, double-click Hit Counter. In Front-
Page 2000, choose Insert | Component | Hit
Counter. In FrontPage 2002, choose Insert | Web
Component; in the dialog box that appears,
select Hit Counter and click Finish.

At this point, the Hit Counter Properties dia-
log box appears. Notice that you have five
counter styles to choose from—as well as the

option to specify a custom picture. It’s that last
option that we’ll use to create our invisible
counter.

Enable the Custom Picture radio button and
type images/blank.gif in the text box. Click OK to
close the dialog box and publish the Web to a
live server.

Note: If your image has a different name or is
stored in a different folder, you’ll need to
modify this relative URL. Always specify the
image’s location relative to the Web’s root
directory—not to the directory in which the
current page is located. For example, if
blank.gif is stored in the images directory and
you’ve added a hit counter to www.myURL
.com/pages/index.htm, you’d still enter
images/blank.gif in the Hit Counter Proper-
ties dialog box.

In Normal mode, you’ll see a [Hit Counter]
placeholder, but this placeholder won’t appear
when you view the page in the browser. Instead,
FrontPage will generate a hit counter, which will
of course be invisible, using blank.gif.

Hidden in plain sight
Now, you may be wondering how you can
check your new hit counter’s value. After all, if
the counter is invisible to your site visitors, it’s
also invisible to you! The trick here is to check
the file where FrontPage stores your counter’s
current value—and to do that you must make
this hidden file visible.

Choose Web Settings from the Tools menu
and switch to the Advanced property sheet,
shown in Figure C. Depending on your version
of FrontPage, you’ll see a check box labeled
Show Documents In Hidden Directories or
Show Hidden Files And Folders. Enable this
check box and click OK.

Now, in Folders view, open the _private
folder. There, you’ll find a file named
index.htm.cnf, where index.htm is the name of the
page that contains the hit counter. (If the page
that contains the counter is stored within a sub-
folder of your Web, you’ll find a corresponding
subfolder in the _private folder; open it to find
the counter file.) Right-click on this file and
choose Open With. In the Open With Editor dia-
log box that appears, double-click on
notepad.exe. The counter file opens in Notepad,
as shown in Figure D, allowing you to check
your counter’s current value.

The FrontPage hit parade

Figure B: Specify
blank.gif as the source
for your counter digits.

Figure C: To check your counter, you must be able to view 
hidden files and folders.
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Figure D: View the configuration file in
Notepad to see your current hit total.

While not as valuable as the usage analysis
reports that FrontPage 2002 introduces, hit coun-
ters are still a useful way to get a quick sense of
the number of users who are visiting a specific
page. By making your hit counters invisible, as
we’ve described in this article, you can continue
tracking hits without displaying a hit counter on
your pages. 

Customize your FrontPage 98 site’s
look with a custom theme
by Mark Ray 

Application: Microsoft FrontPage 98
Operating System: Microsoft Windows

W hen it released FrontPage 2000, 
Microsoft added the ability to edit 
themes within the program. What

many FrontPage 98 users didn’t realize—and
perhaps still don’t—is that you can also edit that
version’s themes. All you have to do is install a
program called Theme Designer, which is found
on your FrontPage 98 CD-ROM.

To install the program, insert the CD-ROM
and locate the program tdsetup.exe. It will be
in the D:\SDK\Themes\Designer directory,
where D: is your CD-ROM drive. Launch this
program and confirm that you want to install
the Microsoft FrontPage Theme Designer.
Installation takes just a moment. The next
time you launch FrontPage Explorer, you’ll
find a Show Theme Designer command on the
Tools menu.

Choose this command to launch the Theme
Designer, shown in Figure A. The program
shows a sample of whichever theme you select,
much like the Choose Theme dialog box does.

Figure A: The separate FrontPage Theme Designer lets you edit
FrontPage 98 themes.

Double-click on whichever element you want to
change, and adjust the settings in the dialog box
that appears. 
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Letters
Features that require server extensions
by Mark Ray 

Application: Microsoft FrontPage 98/2000/2002
Operating System: Microsoft Windows

but when I do that, I have trouble with paragraph
alignment. Why is that, and what can I do about it?

William Lord

W hen I’m typing in FrontPage and press the 
[Enter] key, the program adds an extra space

between my paragraphs. I read on the Web that you
can press [Shift][Enter] instead to get rid of that space,

I ’ve just upgraded to FrontPage 2002 and want to 
use the new Photo Gallery component in my Web.

Unfortunately, my hosting company uses nothing but
UNIX servers; since the SharePoint extensions only
run on Windows 2000, their tech support people say I
can’t use the Photo Gallery component. Is that correct?

Austin Steinholder

Actually, they are wrong on two counts. First
(and most pertinent to your question), the Photo
Gallery component doesn’t require any form of
server extensions. In fact, it will even work on a
disk-based Web.

Note: For an introduction to the Photo Gallery
component, see the article “Build a flashy
online photo album in a flash” in the Novem-
ber 2001 issue of Inside Microsoft FrontPage.

Second, like many people, your tech sup-
port folks are confusing the FrontPage Server
Extensions with SharePoint Team Services.
SharePoint Team Services—which does run ex-
clusively under Windows 2000—is only
required if you’re creating a team Web or using
such SharePoint features as discussion boards,
document libraries and surveys. The FrontPage
Server Extensions, on the other hand, are re-
quired for such features as hit counters, usage
analysis re-ports and search forms.

To make things more complicated, Microsoft
releases a new version of the FrontPage Server
Extensions with each new version of FrontPage.

If your hosting company is still running the 2000
version of the extensions, you won’t be able to
use new FrontPage 2002 features like custom
link bars, although you’ll still be able to use hit
counters and other older features.

Note: For more information about Share-
Point, see the article “Introducing SharePoint
Team Services” in the August 2001 issue of
Inside Microsoft FrontPage.

So how can you tell which features require
which set of extensions? The Microsoft Knowl-
edge Base includes several helpful articles on 
the subject:

FrontPage 2002
http://support.microsoft.com/support/kb
/artcles/Q281/5/32.asp

FrontPage 2000
http://support.microsoft.com/support/kb
/articles/Q232/5/24.asp

FrontPage 98
http://support.microsoft.com/support/kb
/articles/q194/0/51.asp

If you’re specifically interested in FrontPage
2002, you might also want to review the arti-
cle at http://support.microsoft.com/support/kb
/articles/Q281/5/95.asp. It describes each of the
new features in the latest version of FrontPage
and also specifies whether each requires an
extended server. 
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To understand what’s going on here, it’s helpful to turn on paragraph
marks in FrontPage. You can do this by clicking the Show All button
( ) on the Standard toolbar. (The button is called Show/Hide ¶ in
FrontPage 98.)

A section of text preceded by a paragraph mark (¶) can have its own
formatting, but a section of text preceded by a line-break mark ( )
adopts the formatting of the previous paragraph. If you want one para-
graph to be right-aligned, for example, and the next to be centered, you
must press [Enter]—not [Shift][Enter]—between the paragraphs.

As you’ve discovered, doing so adds extra space between the para-
graphs, which may not be desirable. To get rid of this space in FrontPage
2000 or 2002, select both paragraphs and choose Paragraph from the For-
mat menu. In the Paragraph dialog box that appears, shown in Figure A,
enter 0 in the Before and After text boxes in the Spacing section. Click OK
to continue.

The procedure is a little trickier in FrontPage 98. Select the paragraphs
as before and choose Paragraph from the Format menu. In the Paragraph
Properties dialog box that appears, click Style to access the Style dialog
box. Then, switch to the Alignment properties sheet. Enter 0 in the Top
and Bottom text boxes in the Margins section and click OK twice.

If you’re using FrontPage 2002, your pages may include line breaks
disguised as paragraph marks. How could that be? When you paste text
from another program into FrontPage, a smart tag appears, as Figure B
shows. If you choose the Keep Text Only option, FrontPage converts all
the paragraph marks in the text to double line breaks. The visual effect is
the same—paragraphs separated by an extra space—but it’s impossible
to format the paragraphs independently. Fortunately, it’s relatively easy
to go back and replace the line breaks with paragraph marks. 

Inside Microsoft FrontPage 2001 index
T his index is arranged by month and lists all articles covered in 

Inside Microsoft FrontPage during 2001. Element K Journals pro-
vides this index to make the issues you received in 2001 more useful as
a problem-solving resource and to help you locate articles of interest in
issues missing from your collection. You can order back issues by call-
ing Customer Relations at (800) 223-8720. 
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